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     34.FRAMES PAGES 

     THỰC TẬP THIẾT KẾ  
     WEB TRANG KHUNG  
 
 
 

 
BÀI 34 NGÀY 4.7.2009 UTBINH SOẠN  
 
WEBSITE THIẾT LẬP BẰNG TRANG KHUNG ( FRAMES PAGES ) GỒM CÓ 
NHIỀU KHUNG TRONG 1 TRANG . FROTPAGE 2003 CUNG CẤP CHO CÁC 
BẠN 10 MẪU TRANG KHUNG . VÍ DỤ BẠN CHỌN MẪU HEADER , FOOTER 
AND CONTENTS THÍ BẠN CÓ 3 KHUNG TRONG 1 TRANG . KHUNG TRÊN LÀ 
KHUNG BANNER GIỚI THIỆU LOGO HAY TÊN TRANG WEB . KHUNG TRÁI 
LÀ KHUNG DANH MỤC (CONTENTS) CHỨA CÁC LIÊN KẾT . KHUNG LỚN 

BÊN PHẢI LÀ KHUNG CHÍNH ( MAIN ) HIỂN THỊ NỘI DUNG CỦA TỪNG 
TRANG WEB KHI BẠN NHẤP VÀO LIÊN KẾT . CẢ 3 KHUNG NÀY BỊ GIỚI 
HẠN NẰM GỌN TRONG KHỔ MÀN HÌNH BẠN ĐANG DÙNG ( TÔI ĐANG SỬ 
DỤNG 1024 X 768 PIXELS ) VÌ VẬY HIỆN RA THANH TRƯỢT TRONG 
KHUNG CONTENTS VÀ MAIN ĐỂ BẠN XEM ĐƯỢC HẾT NỘI DUNG TRONG 2 
KHUNG NÀY . WEBSITE NÀY CHỈ THIẾT LẬP CÓ 1 TRANG MÀ THÔI . 

TRANG KHUNG CHÍ CÓ KHUNG VIỀN MÀ KHÔNG CHỨA NỘI DUNG NÊN 
TRANG KHUNG CẦN PHẢI ĐI KÈM VỚI NHỬNG TRANG CÓ CHỨA NỘI 
DUNG . ĐÓ LÀ NỘI DUNG CỦA CÁC LIÊN KẾT KHI BẠN NHẤP LÊN NÓ 
TRONG KHUNG CONTENTS .TRANG KHUNG ĐƯỢC CHIA LÀM NHIỀU 
KHUNG , MỖI KHUNG CHỨA 1 TRANG WEB KHÁC . 
 

KẾT QUẢ THỰC TẬP THIẾT KẾ WEB FRAMES PAGES :  
Host Free :  

http://tinyurl.com/utbinh184 hoặc : 
http://minh.byethost5.com/site010709/index.htm 

Host mua :  
http://tinyurl.com/utbinh185 hoặc :  
http://utbinh.com/A7/site010709/index.htm 

VIDEO TUTORIAL : 
DOWNLOAD FILES CỰC RÕ TRONG MEDIAFIRE  

TRANGKHUNG_1.avi (96.75 MB): http://tinyurl.com/utbinh186 
Hoặc :http://www.mediafire.com/download.php?dm4cnt2zknk 

TRANGKHUNG_2.avi (83.73 MB) : http://tinyurl.com/utbinh187 
Hoặc :http://www.mediafire.com/download.php?2ynumkx1n43 
XEM TRỰC TIẾP TRÊN YOU TUBE : 

FRONTPAGE 2003 THỰC TẬP FRAME PAGE (TẬP1) Ngày 3. 7.2009 
http://www.youtube.com/watch?v=2vJScNvaAOE 

 

http://tinyurl.com/utbinh184
http://minh.byethost5.com/site010709/index.htm
http://tinyurl.com/utbinh185
http://utbinh.com/A7/site010709/index.htm
http://tinyurl.com/utbinh186
http://www.mediafire.com/download.php?dm4cnt2zknk
http://tinyurl.com/utbinh187
http://www.mediafire.com/download.php?2ynumkx1n43
http://www.youtube.com/watch?v=2vJScNvaAOE
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FRONTPAGE 2003 THỰC TẬP FRAME PAGE (TẬP2) Ngày 3. 7.2009 
http://www.youtube.com/watch?v=EPgM82C57Yg 

FRONTPAGE 2003 THỰC TẬP FRAME PAGE (TẬP3) Ngày 3. 7.2009 
http://www.youtube.com/watch?v=d0QqdF8lQyY 

FRONTPAGE 2003 THỰC TẬP FRAME PAGE (TẬP4) Ngày 3. 7.2009 
http://www.youtube.com/watch?v=WWkXPFcuN8s 

FRONTPAGE 2003 THỰC TẬP FRAME PAGE (TẬP5) Ngày 3. 7.2009 
http://www.youtube.com/watch?v=4UX04URpJFY 

 

mục lục : 
 
LINKS URL KẾT QUẢ THỰC TẬP THIẾT KẾ WEB FRAMES PAGES . 

1.CHỌN MẪU FRAMES PAGES . 
2.KHUNG BANNER . 

3.KHUNG  DANH MỤC ( CONTENTS ) : Chứa các Liên kết . 
4.CÁCH TẠO TẬP TIN .HTM BẰNG CÁC FILE VĂN BẢN  . 
5.KHUNG CHÍNH ( MAIN ) : Khung bên Phải. 

6.KHUNG ĐÁY ( BOTTOM ) : Chứa Thông Tin của Website . 
7.HIỆU CHỈNH WEBSITE . 

8.UPLOAD FOLDER WEBSITE LÊN HOST SERVER FREE   
 

1. CHỌN MẪU FRAMES PAGES :  
 
Mở FP > File > New > More page templates > HT Page Templates , nhấp Tab 

Frames Pages > Chọn Mẫu Header , Footer and Contents > Ok > Hiện ra Mẫu đã 
chọn . Nếu không thấy Folder List hiện ra hãy nhấp View > Folder List . (H1) . 

 
 

 
 
 

 
 

 
 

 
 
 

 
 

 
 
 

 
 

 
 

 
 
 

 

http://www.youtube.com/watch?v=EPgM82C57Yg
http://www.youtube.com/watch?v=d0QqdF8lQyY
http://www.youtube.com/watch?v=WWkXPFcuN8s
http://www.youtube.com/watch?v=4UX04URpJFY
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2. KHUNG BANNER : 
 

 Insert Banner :  

 
Nhấp Nút New Page > Một Khung trống mở ra > Insert > Picture > From 

File > Đến nơi đã lưu Banner được tạo bằng Photoshop đặt tại Desktop 
trước đó hoặc chọn 1 File hình ảnh JPG hay Gif trong máy Bạn hay trên 
Mạng > Insert > Đã hiện ra Banner trong Khung Banner nhưng nằm lệch 

trong Khung . Để chỉnh sửa bạn nhấp Banner > Bật Thanh Công Cụ 
Pictures > Nút Potion Absolutely > Rê Banner đặt đúng vị trí > Nhấp bên 

ngoài bỏ chọn . (H2) . 
 
 

 
 

 
 

 
 Save Khung Banner :  

 
Nhấp vào trong Khung > Nút Save > HT Save As xuất hiện , bên Phải có 

hiển thị Khung Banner được chọn màu xanh , hàng File Name nhập : 
header > Nhấp nút Change Title , nhập : Header Frame > Ok > Trở lại HT 
Save As > Save . (H3) . 

 
 

 
 

 
 
 

 
 

 
 
 

 
 

 
 

 
 
 

 
 

 
o Hiện ra HT Save Embedded Files có File Banner.jpg mà bạn vừa thêm 

vào trong Web . Bạn nên lưu nó trong Folder để không hiện ra trong 
Folder List rối mắt > Nhấp nút Change Folder > Chọn Folder Borders  
( Folder này do FP tạo ra khi chọn kiểu Frames Pages ) > Ok > Ok > 

(H4) . 
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o Phần trên là hướng dẫn bạn lưu Khung Banner , FP tự động hiện ra 

tiếp theo HT Save As với Preview Toàn Bộ Khung ( Cả 4 Khung là : 

Banner – Contents – Main – Bottom ) . Bạn cần phải lưu Toàn Bộ 
Khung và Khung này sẽ hiện ra cùng với nội dung khi nhấp File : 

index.htm . Hàng Save In : My Web Site – Khung Name đã có File 
Header bạn đã lưu trước đó – Hàng File Name để mặc định  : index > 

Nhấp nút Change Title , nhập : Frames Templates > Ok > Save . (H5)  
 
 

 
 

 
 

 
 
 

 
 

 
 
 

 
 

 
 

 
 
 

 
 

o  Trong Folder List hiện ra thêm File index .htm  . Đây là Trang Chủ 
của toàn bộ Trang Khung đang hiển thị bên Phải và Trang 

header.htm ( Khung Banner ) bạn đã lưu trước đó . Trong Folder 
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Borders do FP tự tạo , nhấp lên Folder này bạn đã thấy File 
Banner.jpg đã lưu trước đó và 3 Files do FP tạo ra . Tất cả các Files 

được đặt trong Đường Dẫn bên trên : My Documents > My Web Sites 
(H6) . 

 
 

 
 
 

 
 

 
 
 

 
 

 
 

3.KHUNG  DANH MỤC ( CONTENTS ) : Chứa các Liên kết . 
 

Nhấp Nút New Page > Một Khung trống mở ra > Nhập các Từ để chuẩn bị tạo 
liên kết cho nó > Nhấp Nút Decrease Font Size thu nhỏ Size lại . 
 

 Tạo liên kết cho Từ : WEBSITE UTBINH  

 
o Bôi đen WEBSITE UTBINH > Nút Insert Hyperlink > Hàng Address 

nhập : http://utbinh.com > Ok . (H7) . 

 
 

 
 

 
 
 

 
 

 
 
 

 
 

 
 

 
 
 

 
o Chọn Khung Contents > Nhấp Nút save > HT Save As hiện ra > Bên 

phải cho thấy Khung Contents được tô xanh đậm > File name nhập : 
contents > Nhấp nút Change Title , hàng Page Title nhập : Contents 

Frame > Ok > Save . (H8) . 
 

http://utbinh.com/
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o Từ : WEBSITE UTBINH đã có gạch dưới , màu xanh bào hiệu có liên 
kết >  Nhấp lên từ này > Trong Khung Main đã hiện ra nội dung của 

liên kết này , do Trang Web quá dài bạn kéo Thanh Trượt xuống để 
xem toàn bộ Trang Web . (H10) . 

 
 
 

 
 

 
 

 
 
 

 
 

 
 
 

 
 

 
 

 
 
 

 
 

o Xem kiểu Normal : Nhấp Preview > Nhấp lên Liên Kết . (H9) . 
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o Xem kiểu Trình Duyệt > Nhấp F12 > Yes > Hiện ra Trình Duyệt có 

nội dung  của Liên kết . 
o Các Từ còn lại tạo liên kết giống các bước trên . 

 Các Tập tin htm sẽ liên kết với các Từ : 

 

 
 
 

 
 

 
 
 

 
 

 
 

 
Website utbinh      : http://utbinh.com/  
You Tube utbinh    : http://www.youtube.com/designutbinh 

Website Đức           : http://geo05.com/ 
Website150609      : http://utbinh.com/A6/site150609/index.htm 

Website120609      : http://minh.byethost5.com/120609/index.htm 
Link Trang Khung   : http://utbinh.com/A7/trangkhung/khung.htm 

Links 6.2009          : http://utbinh.com/A7/links6.2009/linksJUN2009.htm 
Links Bài 3 – 4       : http://utbinh.com/A7/bocuc/bocuctrang.htm 
Links bài 5             : http://utbinh.com/A7/bai5/bai5.htm 

Links Tổng Hợp 6.2009 : http://utbinh.com/A7/links/LinksJUN2009.htm 

http://utbinh.com/
http://www.youtube.com/designutbinh
http://geo05.com/
http://utbinh.com/A6/site150609/index.htm
http://minh.byethost5.com/120609/index.htm
http://utbinh.com/A7/trangkhung/khung.htm
http://utbinh.com/A7/links6.2009/linksJUN2009.htm
http://utbinh.com/A7/bocuc/bocuctrang.htm
http://utbinh.com/A7/bai5/bai5.htm
http://utbinh.com/A7/links/LinksJUN2009.htm
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4.CÁCH TẠO TẬP TIN .HTM BẰNG CÁC FILE VĂN BẢN  : 
 

Trong bài này bạn thấy các Từ : Website Bài 3 và 4 – Website bài 5 . Nhấp lên 

Liên Kết này sẽ hiện ra nội dung Text có kèm hình hoặc thuần túy Text . Bạn cần 
phải tạo từ 1 File Text > Save với định dạng Web Page > Tạo 1 Folder Website 

chứa 2 File do Word tạo ra khi chọn Định dạng Web Page để lưu > Rê Folder 
Website lên Host để lấy Link Tập Tin.htm . Đó là Link liên kết với Từ để hiển thị 

nội dung trong Khung Chính (Main ) .  
 
Cách thực hiện như sau : 

 
 Mở bài 5 trong Word : Bố Cục trang Web với Khung ( Bài này có rất nhiều 

Hình Minh Họa kèm theo ) > Save As > Chọn Other Format > Nơi lưu kết 
quả chọn desktop > File name nhập : bai5 > Save As Type chọn : Web 

Page > Save . 
 Ra Desktop đã có 1 File tên : bai5 và 1 Folder tên bai5_files > Nhấp lên 

Folder này > Bạn thấy tất cả Hình trong Bài 5 và một số Files do FP tạo ra . 
 Tạo 1 Folder tên BAI5 > Rê File bai5 và Folder bai5_files vào đây . 

 Upload BAI5 lên Host Server > Sau khi Upload hoàn tất bạn có tên Tập 

tin.htm của Bài Text này là : 
http://utbinh.com/BAI5/bai5.htm . Giải thích Link URL này : 

o http://utbinh.com ( Tên Host Server )  
o BAI5 ( Tên Folder bạn đã Upload lên )  
o bai5.htm ( Tên File trong Folder BAI5 ) .(H12) . 

 
 

 
 

 
 
 

 
 

 
 

 
 
 

 
 

 
 
 

 
 

 
 

 
 
 

http://utbinh.com/BAI5/bai5.htm
http://utbinh.com/
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5. KHUNG CHÍNH ( MAIN ) : Khung bên Phải  
 

 Nhấp Nút New Page > Một Trang trống mở ra > Copy Văn bản > Paste vào  

 Nút save > Bên Phải cho thấy Khung Main được tô xanh , File Name nhập : 
main > Nhấp Change Title , nhập : Main Frame  > Ok > Save .( H13) . 

 
 

 
 

 
 
 

 
 

 
 
 

 
 

 
 

 
 
 

 
 

 
 Trong nội dung bạn có Paste 1 Hình vào nên hiện ra HT Save Embedded 

Files  , FP nhớ mặc định lưu trong Folder Border vì vậy bạn chỉ cần nhấp Ok 
. (H14) . 

 
 

 
 
 

 
 

 
 
 

 
 

 
 

 
 
 

 
 

 Phím F12 > Bạn xem trong Trình Duyệt Khung Chính ( Main ) có nội dung 
vừa nhập . (H15) . 
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   6.KHUNG ĐÁY ( BOTTOM ) : Chứa Thông Tin của Website . 
 

Bạn nhập văn bản : Gởi E-mail cho Webmaster với những câu hỏi và ý kiến 
về Website này > Định dạng chúng . 
 

 Tạo liên kết cho Webmaster :  
 

Trong Ô cuối Trang , nhấp đúp từ Webmaster để chọn nó > Nút Insert 
Hyperlink > Hiện ra HT Insert Hyperlink , nhấp Mục E-mail Address > Trong 

hộp E-mail Address , nhập : Webmaster@gardenco.mns.com . Từ mailto: sẽ 
tự động chèn vào đầu dòng – Trong Hộp Subject , nhập : Web site feedback  

nhằm thiết lập dòng chủ đề của mỗi thông điệp được phát sinh từ liên kết 
để bạn dễ dàng xác định nguồn góc của chúng > Nhấp Nút ScreenTips , 
nhập  : E-mail the Webmaster ! trong hộp ScreenTip Text > Ok để thiết lập 

văn bản ScreenTip cho liên kết > Ok > Close Trang Index.htm  > Save . 
(H16) . 

 
o Nút save > HT Save As , hàng File name nhập : bottom > Nút Change 

Title , nhập : Bottom Frame > Ok > Save . 
o F12 > Nhấp lên Webmaster > Hiện ra Hộp Thư với To là :          
o utbinhdesign@gmail.com . (H16) . 

 
 

 

mailto:Webmaster@gardenco.mns.com
mailto:utbinhdesign@gmail.com
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   7.HIỆU CHỈNH WEBSITE: 
 

Trong Trang Khung của bạn cò 4 Khung , muốn sữa chữa Khung nào thì nhấp 

chọn Khung đó > Menu Frames . 
 

 Chia Khung : Nhấp Split Frame > Muốn Khung vừa chọn thành 2 Cột thì 
chọn Split into Columns > Chia Khung thành 2 hàng chọn Split into 

Rows . (H17) . 
 

 
 

 
 
 

 
 

 Xóa Khung : Frames > Delete Frame . 
 Thay đổi kích thước Khung : Để con trỏ lên đường biên Khung > rê . 

 Thay đổi các chi tiết nhỏ : Menu Frames > Frame Properties , HT Frame 

Properties hiện ra . (H18) . 
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o Title : Nhập tên mới cho Khung . 
o Initial Page : Nhập tên Tập Tin .htm khác để thay đổi nội dung . 

o Mục Frame Size : Nhập giá trị khác để thay đổi kích thước . 
o Mục Margins : Nhập giá trị để thay đổi biên . 

o Mục Options : Nếu đánh dấu vào Resizable in Browser thì bạn sẽ 
cho phép thay đổi kích thước Khung . Hậu quả sẽ làm hư bố cục 

Trang . 
o Không hiển thị viền : Nhấp Frame Page > Không chọn Show 

Borders hoặc nhấp Frame Spacing =0 . (H19) . 

 
 

 
 
 

 
 

 
 

 
 
 

 
 

 
 

o Mục Show Scrollbars : Đối với Thanh Cuộn . 
 If needed : Không hiển thị khi nội dung ngắn và hiển thị khi 

nội dung dài . 

 Never : Không bao giờ hiển thị . 
 Always : Luôn luôn hiển thị > F12 > Close . 

 

   8.UPLOAD FOLDER WEBSITE LÊN HOST SERVER FREE  : 
 

1. Tìm Host Free và cách Upload Folder Website : Có nhiều đọc giả hỏi utbinh 
cách tìm Host Free và cách Upload Folder Website lên Host Server . Utbinh 

đã viết hướng dẫn rất chi tiết trong các bài trước . Nay utbinh sẽ giới thiệu 
nội dung trên bằng File Video Tutorial , mong các bạn đón xem . 

2. Folder Website : Sau khi bạn đã hoàn tất Thiết Kế Trang Web bằng Mẫu 
TRANG KHUNG ( FRAMES PAGES ) , bạn nhấp Phím F12 để xem trong Trình 

Duyệt . Bạn nhấp Yes và Trình Duyệt mở ra nội dung Trang Khung  . Như 
vậy là bạn đã Save All toàn bộ Trang Web vừa thiết kế . Do đặc tính của 
Trang Khung khác với các kiểu Thiết Kế mẫu khác mà bạn đã tham khảo 

trước đây , Folder Website của bạn giờ đây là Folder Web Sites . 
3. Nội dung của Web Sites : Nhấp My Documents > My Web Sites > Bạn thấy 

4 Khung là Header – Contents – Main – Bottom và 1 Trang Index . Bạn 
Copy Folder Web Sites > Paste lên Desktop > Rename tên : site010709  

( Ngày thiết kế Trang Web ) . 
4. Upload Folder site010709 lên Host Server Free :  

 Nhấp Shortcut Chương Trình Cute FTP Pro 3.0 tại Desktop > Hiện ra 

giao diện của Chương Trình > Cột Trái nhấp Ta Manager > Nhấp tên 

Host Free > Cột Trái hiện ra nội dung của Ổ Cứng > Cột Phải chứa 



13 
 

nội dung của Host Free > Nhấp Folder htdocts ( Đặc tính riêng của 
Host Free Buyethost.com ) > Rê site010709 từ bên Trái qua Phải  

( Rê từ Khu vực Ổ Cứng của máy bạn lên Host Server Free) . 
 Khi Upload hoàn tất sẽ có những dấu hiệu sau đây : Đã có tên 

site010709 tại Khu vực của Host – Khung giữa hiện chữ : Directory 
listing completed – Khung đáy có : tên site – dung lượng siote – 

100% hoàn tất – Đường dẫn vị trí site tại máy bạn .(H20) . 
 

 
 

 
 
 

 
 

 
 
 

 
 

 
 

 
 
 

 
 

 
 

 
 
 

 Nhấp lên site010709 hiện ra nội dung trong đó . (H21). 

 
 
 

 
 

 
 
 

 
 

 
 

 
 URL của site010709 sẽ là : 

http://minh.byethost5.com/site010709/index.htm 
Giải thích : 

http://minh.byethost5.com : Tên Host Free www.byethost.com khi 
bạn đăng ký tạo Account nó cho Đường dẫn này . 
site010709 : Folder Website mà bạn đã Upload lên Host Free này . 

http://minh.byethost5.com/site010709/index.htm
http://minh.byethost5.com/
http://www.byethost.com/
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index.htm : Trang Chủ Trang web Frames Pages .(H22) . 
 

 
 

 
 

 
 
 

 
 

 
 
 

 
 

 
 

 
 
 

 
 

 
 

 
 
 

 Cách đăng ký tạo Account Host Free BYETHOST , xem trong :  

http://utbinh.byethost10.com/030409/byethost.doc  

 
 
 
 

 
 
 
 
 
 

 
 
 
 
 
 

http://utbinh.byethost10.com/030409/byethost.doc

